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Introduction 

Application Access Controls Governor (AACG) regulates access to duties assigned in 
business-management applications. By default it controls access to Oracle E-Business 
Suite and PeopleSoft Enterprise, and it may be configured to work with other business-
management applications as well. It implements “access policies,” which identify duties 
that are considered to conflict with one another because, in combination, they would 
enable individual users to complete transactions that may expose a company to risk. 

Within any business-management application, AACG can recognize policy conflicts 
after duties are assigned to users. In Oracle E-Business Suite or PeopleSoft Enterprise, 
version 8.2.1 of AACG can also implement “User Provisioning” — it can evaluate 
access policies as roles or responsibilities are assigned to users, preventing them 
from gaining risky access.  

To run version 8.2.1, you must upgrade to it from version 8.2.0; you cannot install 
version 8.2.1 directly. To implement version 8.2.0, you may install it directly, or you 
may upgrade to it from any of versions 8.0, 8.01, 8.1, or 8.1.1. To perform the ver-
sion 8.2.0 installation or upgrade, see the Installation and Upgrade Guide for version 
8.2.0. Then, to upgrade to version 8.2.1, complete the following steps. 

1. To implement User Provisioning in Oracle EBS instances, ensure that version 
7.3.1 of Preventive Controls Governor (PCG) is installed in each Oracle EBS 
instance that is subject to AACG analysis. (Earlier versions of AACG permitted 
the use of earlier PCG versions, but AACG 8.2.1 requires version 7.3.1 of PCG.) 

PCG is a set of applications which primarily apply controls within Oracle EBS, 
but which also support User Provisioning in AACG. For installation instructions, 
see the Preventive Controls Governor Installation Guide for version 7.3.1. 

There is no similar prerequisite for implementing User Provisioning in a 
PeopleSoft instance. 

2. Upgrade to version 8.2.1 of AACG from version 8.2.0: 

• Use the database and software components already installed for version 
8.2.0. (These are listed in the “Prerequisites” section on page 1-2.) 

• Download AACG files. (AACG also requires certain open-architecture 
files. If you preserved those downloaded for version 8.2.0, there is no need 
to download them again.) 

• Perform the AACG upgrade. 
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To complete these procedures, see Chapter 2 of this manual. Because this upgrade 
reuses the database already installed for version 8.2.0, it inherits certain informa-
tion, which need not be reconfigured. This includes:  

• “Global user” configuration — criteria for identifying business-application 
users, whose IDs in those applications may vary from one application to 
another. For more on global user configuration, see the Installation and 
Upgrade Guide for version 8.2.0 

• Connections to business-management applications over which access pol-
icies created in AACG will exercise control. For more on configuring “data 
source” connections, see the User Guide for version 8.2.1. 

3. Perform an additional Provisioning Embedded Agent (PEA) installation in each 
instance of Oracle EBS or PeopleSoft that is to be subject to User Provisioning. 
For Oracle PEA installation, see Chapter 3 of this manual; for PeopleSoft PEA 
installation, see Chapter 4.  

If you want to upgrade from version 7.2.3 or earlier of Application Access Controls 
Governor, perform a new installation of version 8.2.0, upgrade it to version 8.2.1, and 
then use the AACG migration utility to copy earlier-version SOD rules into the version-
8.2.1 instance. (The migration process converts SOD rules into access policies). For 
information on using the migration utility, see the User Guide for version 8.2.1.  

Supported Operating Systems 

Application Access Controls Governor runs on a server with, by preference, a Linux 
operating system. Windows Server is also supported. For detailed information about 
supported operating systems, see the Oracle Governance, Risk, and Compliance 
Controls Suite Compatibility Matrix. 

Prerequisites 

Before installing Application Access Controls Governor, ensure that the following 
are installed on the server: 

• Oracle 10g database. 

• Tomcat Application Server version 5.5 

Moreover, if you are installing on a Linux server, you must have Sun Java Develop-
ment Kit 1.5. If you are installing on a Windows server, you may use the Sun JDK 
or JRockit R27.5.0 for Java SE 6; the latter is recommended. In any case, AACG must 
have its own dedicated Java container. It was not designed to coexist in a container 
with other web applications (even other applications in the Governance, Risk, and 
Compliance Controls Suite). 

On the server or a client system, either of the following web browsers can display 
the AACG interface: 

– FireFox 2.x 

– Microsoft Internet Explorer 6 or 7, with the Adobe SVG plugin available 
from http://www.adobe.com/svg/viewer/install/mainframed.html. 
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Upgrading AACG 

In broad terms, complete these steps to upgrade version 8.2.0 of Application Access 
Controls Governor to version 8.2.1: 

1. Download files to the AACG server and prepare them for use. 

2. Install and configure the software. 

Noting Your Current Settings 

For version 8.2.0, you have already configured settings that establish connectivity 
between Application Access Controls Governor and its database. As you upgrade to 
8.2.1, you will need to re-enter these settings. Take note of them now, so that you 
will have them at hand when you need to re-enter them.  

1. Start your existing version-8.2.0 instance of AACG: Open a web browser and, 
in its address field, enter the following: 

http://host:tomcat_port/ags 

Replace host with the fully qualified domain name (FQDN) of your Application 
Access Controls Governor server, and replace tomcat_port with 8080 (if you 
accepted the default value when you installed Tomcat) or your configured value 
(if you changed the default during Tomcat installation). 

2. Log on to AACG: Supply your user name and password, and click on Login. 

3. In the Navigation panel (to the left on the AACG interface), expand the Administra-
tion entry (click on its plus sign), and then click on Application Configuration. 

4. An Application Configuration panel displays the settings you’ve established for 
most database-connectivity parameters. (For security purposes, it does not dis-
play the AACG database password.) Make a copy of the settings. (For example, 
highlight the fields displaying your settings by dragging your mouse across them, 
click on Ctrl+C to copy the settings, open a word processor or spreadsheet, and 
press Ctrl+V to paste in the copied settings.) 
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Backing Up the AACG Schema 
Application Access Controls Governor requires a schema in an Oracle 10g database. 
For version 8.2.1, use the schema already created for version 8.2.0. Before upgrading, 
take a backup of your AACG schema 

To use the multilingual capabilities of AACG, make sure the database that hosts the 
AACG schema is set up for UTF-8 encoding. Specifically, the character set should 
be set to AL32UTF8. Refer to your Oracle Admin guide for more information on 
verifying or configuring your database with the recommended character set. 

Downloading Files 
Before downloading files, create a staging directory on the Active Access Controls 
Governor server. When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Suite Disk in your 
Oracle media pack. In its dist directory, locate the file acg_821.zip. Copy the file 
to your staging directory, and extract its contents there.  

2. One of the files you’ve extracted is called ags.war. Execute the following com-
mand to validate it.  

md5sum ags.war 

In response to this command, a checksum value is returned. Ensure that it matches 
the following value: 

fa7cdda009dee416efa65829ca3285fd 

3. Certain open-architecture files are required. You will have already downloaded 
these files to the staging directory you created as you installed version 8.2.0. If 
you have not removed them, you can reuse them for version 8.2.1, and so need 
not download them again. If you have removed them, download files from the 
following sites to your version-8.2.1 staging directory. 

jasperreports-1.3.2.jar 
A Java reporting system 
License: 

http://www.jasperforge.org/index.php?option=com_content&
task=view&id=81&Itemid=89 

Download: 
http://mirrors.ibiblio.org/pub/mirrors/maven/jasperreports
/jars/jasperreports-1.3.2.jar 

Depending on the web browser you use, the file may download as 
jasperreports-1.3.2.zip; if so, change its name to jasperreports-1.3.2.jar. (If 
the file downloads as jasperreports-1.3.2.jar, do not change its name.) 

kettle-2.5.2.jar 
common-2.5.jar 
cache-2.5.jar 
jxl-2.5.jar 
javadbf-2.5.jar 
js-2.5.jar 
A metadata-driven ETL tool  
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License: 
http://wiki.pentaho.com/display/EAI/PDI+License+FAQ 

Download 
http://sourceforge.net/project/downloading.php?group_id=
140317&use_mirror=superb-west&filename=Kettle-
2.5.2.zip&95414959 

xpp3_min-1.1.3.4.O.jar 
A streaming pull XML parser  
License: 

http://www.extreme.indiana.edu/viewcvs/~checkout~/XPP3/java
/LICENSE.txt 

Download:  
http://www.extreme.indiana.edu/dist/java-
repository/xpp3/jars/xpp3_min-1.1.3.4.O.jar 

As you download this file, be sure to change its name from xpp3_min-
1.1.3.4.O.zip to xpp3_min-1.1.3.4.O.jar. 

edtFTPj-1.5.3.jar 
Kettle dependency 
License: 

http://www.enterprisedt.com/products/edtftpj 
Download: 

http://www.findjar.com/jar/com.enterprisedt/jars/edtFTPj
-1.5.3.jar.html 

A findJAR page opens; click on its download link. The download file is origi-
nally named edtFTPj-1.5.3.zip. Change its name to edtFTPj-1.5.3.jar.  

4. If you have downloaded open-architecture files for version 8.2.1, prepare the 
Kettle files you’ve downloaded by completing the following tasks. (If you are 
reusing the files downloaded for version 8.2.0, you have already completed 
these tasks and  need not repeat them.) 

• Create a subdirectory of your staging directory, called lib_stage. 

• Extract the contents of Kettle-2.5.2.zip in the lib_stage subdirectory. 

• From the staging directory, execute the following commands. In each, 
replace the value stagedir with the name of your staging directory: 

cp lib_stage/Kettle-2.5.2/libswt/common.jar 
stagedir/common-2.5.jar 

cp lib_stage/Kettle-2.5.2/libext/CacheDB.jar 
stagedir/cache-2.5.jar 

cp lib_stage/Kettle-2.5.2/libext/jxl.jar stagedir/jxl-
2.5.jar 

cp lib_stage/Kettle-2.5.2/libext/javadbf.jar 
stagedir/javadbf-2.5.jar 

cp lib_stage/Kettle-2.5.2/libext/js.jar stagedir/js-2.5.jar 

cp lib_stage/Kettle-2.5.2/lib/kettle.jar 
stagedir/kettle-2.5.2.jar 
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Performing the Upgrade 

When the necessary files are downloaded, complete these steps: 

1. Shut down the Tomcat application server (or, if you are installing on a Windows 
server and run Tomcat as a Windows service, stop the service). 

2. Remove the directory TomcatHome/ webapps/ags, and all its contents. Also re-
move the ags directory from the Tomcat work area (TomcatHome/work/Catalina/ 
localhost/ags). You may want to save Tomcat logs (located at TomcatHome/logs) 
to another location, then delete them. 

Note: Throughout this document, replace the value TomcatHome with the full 
path to the highest-level directory in which Tomcat components are installed. 

3. Copy the file ags.war from your version-8.2.1 staging directory to 
TomcatHome/webapps. This copy operation overwrites an older version of 
ags.war.  

Certain modifications to Tomcat settings are necessary for AACG, but you are 
assumed to have made these modifications during installation of AACG 8.2.0. 
There is no need to make them again. 

4. Start the Tomcat application server (or if you run Tomcat as a Windows service, 
start the service). 

5. Open a web browser and, in its address field, enter the following: 

http://host:tomcat_port/ags 

Replace host with the FQDN of your Application Access Controls Governor 
server, and replace tomcat_port with 8080 (if you accepted the default value 
when you installed Tomcat) or your configured value (if you changed the 
default during installation).  

6. An Application Configuration panel appears, with a Properties tab selected. 
(Ignore the Analytics Integration and User Integration tabs.)  

In the Database section of the Properties panel, supply the following informa-
tion about the AACG database. (These correspond to values you recorded in 
“Noting Your Current Settings” on page 2-1.) 

• User Name: Supply the user name for the AACG database.  

• Password: Supply the password for the AACG database.  

• Confirm Password: Re-enter the password for the AACG database.  

• Port Number: Supply the port number at which the AACG database server 
communicates with other applications.  

• Server Identifier: Supply the service identifier (SID) for the AACG database 
server.  

• Server Name: Supply the FQDN of the database server.  

• Report Repository Path: Supply the full path to the Report Repository. This 
is a directory, created during the installation of version 8.2.0, that stores AACG 
report history — copies of reports that AACG users schedule to be run.   

• Log Threshold: Select a value that sets the level of detail in log-file entries. 
From least to greatest detail, valid entries are error, warn, info, and debug.  
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A Third-Party Libraries section presents a single field, Third-Party Library Path. 
In it, enter the full path to the directory into which you downloaded third-party 
jar files (see step 3 on page 2-2), which is either of the following: 

• If you are reusing the files downloaded during 8.2.0 installation, the staging 
directory for version 8.2.0  

• If you downloaded the files once again for the 8.2.1 upgrade, the staging 
directory for version 8.2.1.  

This enables AACG, as you complete the upgrade, to copy the files to a direc-
tory in which AACG can use them. (When this copy operation is complete, the 
Third-Party Libraries section no longer appears in the Application Configuration 
panel.) 

In the Performance Configuration section, select or clear the Externalize Report 
Engine check box. Selecting it causes the AACG reporting engine to run in its own 
Java process, so that the generation of large reports does not impact other func-
tionality. Select it, however, only if you are installing AACG on hardware identified 
as “preferred” in a document titled AACG 8.x Hardware Platform Requirement. 

In the Language Preferences section, select the check boxes for up to twelve lan-
guages in which you want AACG to be able to display information to its users. 
Once selected in the Properties panel, these languages are available for selection 
by individual users as they configure their user profiles or as they log on to AACG.  

7. In the Application Configuration panel, click on the Test button to validate the 
parameter values you’ve entered. Upon passage of the test (if AACG can con-
nect to its database and if it can read the directory path for the Report Repository), 
a Save button becomes active. Click on it to save the settings.  

8. Exit the Application Configuration panel. Shut down the Tomcat application 
server (or, if you run Tomcat as a Windows service, stop the service). 

9. Restart the Tomcat application server (or, if you run Tomcat as a Windows 
service, restart the service). 

10. Open a web browser and, in its address field, enter the following: 

http://host:tomcat_port/ags 

Replace host with the FQDN of your Application Access Controls Governor 
server, and replace tomcat_port with 8080 (if you accepted the default value 
when you installed Tomcat) or your configured value (if you changed the 
default during installation).  

11. Examine the progress meter displayed on the web browser, and wait for it to 
complete. The progress meter may take several minutes to appear. 

12. Check the upgrade log (TomcatHome/webapps/ags/log/ags.log), in particular to 
determine whether an “Overall status of schema updates” entry is set to success. 
If not, contact Oracle Support. If so, proceed to set 13. (You may also consult 
the log for information about other problems with the upgrade, if any occur.) 

13. Shut down the Tomcat application server (or, if you run Tomcat as a Windows 
service, stop the service). Wait for a popup message that instructs you to restart 
the application server; when it appears, clear the message and restart Tomcat (or 
the Windows service in which it runs). 
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Validating Downloaded Files 

To ensure that files have downloaded correctly, calculate their checksums. (Or, if 
you are reusing third-party files downloaded and validated for version 8.2.0, skip 
this section.) To validate files, navigate to the directory TomcatHome/webapps/ags/ 
WEB-INF/lib. Then run the following command for each file, substituting the actual 
file name for the placeholder filename: 

md5sum filename 

Then, ensure that the checksum value returned for each file matches the value shown 
in the following table:  

File Name Checksum Value 

jasperreports-1.3.2.jar 57e79eae691a4fe16b50ee921ab9117a 

kettle-2.5.2.jar f4615e347bd54e7536010ccb8ff83444 

common-2.5.jar 8ab087f48815d80fe81a1e0cc8ad3345 

cache-2.5.jar 35c92597232fd096bac276f3253abee5 

jxl-2.5.jar cb0b83e999a76364ed6b554dfc354d11 

javadbf-2.5.jar eb4da2d1f8ba245a2cc6605d50c64f9f  

js-2.5.jar b9c260c5b03c0e8511119a7fb87650d8 

xpp3_min-1.1.3.4.O.jar 58908507281834b123024eb6d9be0b7e 

edtFTPj-1.5.3.jar 5273ebd698dd7268732a554d47e655b0 

Data Sources 

As noted earlier, the version 8.2.1 upgrade inherits data-source configuration from 
the version-8.2.0 installation; that is, it is already connected to business-management 
applications in which it will implement access policies. You need not repeat this 
configuration. (For information on configuring new data sources, however, see the 
User Guide for version 8.2.1.) 

AACG assigns an ID number to each data source. If you intend to enable User 
Provisioning for an Oracle EBS or PeopleSoft data source (see Chapters 3 and 4), you 
will need to know its data source ID. To determine the number: 

1. log on to AACG. In a web browser, enter the following, in which host repre-
sents the FQDN of your AACG server, and tomcat_port is replaced by 8080 (if 
you accepted the default value when you installed Tomcat) or your configured 
value (if you changed the default during Tomcat installation). 

http://host:tomcat_port/ags 

2. In the Navigation panel (to the left of the AACG interface), expand the Admin-
istration entry (click on its + sign) and select (click on) the Data Administration 
entry in the Administration list.  

3. Right-click on the header row in the Data Administration panel. 

4. A menu appears. Position the mouse cursor over its Columns option; a list of 
available columns appears.  
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5. In that list, select the check box for the Data Source ID column (click on it so 
that a check mark appears).  

6. Left-click anywhere outside of the menu and list of columns to close them.  

7. The Data Administration panel now displays a Data Source ID column. In it, 
note the ID number assigned to the data source. 

If, having determined the data source IDs for your data sources, you wish to remove 
the Data Source ID column from view, repeat this procedure but clear the Data Source 
ID check box (click on it so that the check mark disappears). 
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Installing the Oracle PEA 

In support of the AACG User Provisioning feature, install a Provisioning Embedded 
Agent (PEA) on each instance of Oracle E-Business Suite that is to be subject to AACG 
analysis. Installations on Oracle EBS 11.5.10 and R12 (12.0.4) are supported. Even if 
you have installed the PEA for version 8.2.0, you must reinstall it for version 8.2.1. 

On each EBS instance for which you want to enable User Provisioning, you must 
install version 7.3.1 of Preventive Controls Governor (PCG) before installing ver-
sion 8.2.1 of the PEA. Keep the following in mind: 

• You can install AACG 8.2.1 on its server without first having installed PCG on 
any EBS instance. If so, however, AACG would not be able to apply User Pro-
visioning to Oracle EBS instances. You can implement User Provisioning sub-
sequently; to do so, you would first install PCG, then the PEA, on each EBS 
instance for which you want to enable User Provisioning.  

• Even after User Provisioning is enabled, you may choose to reinstall PCG on an 
EBS instance. If so, you must also reinstall the PEA on that instance. 

This chapter describes an automated PEA installer and a manual PEA installation 
process. If the Oracle EBS concurrent manager server and forms server reside on 
the same instance, attempt automated installation first, as it’s simpler. If not, or if 
the automated installer fails, use the manual process. In either case, first complete 
some preliminary steps that apply to both automated and manual installations.  

Preliminary Steps 
If you run your Oracle EBS instance in the Linux operating system, you must set a 
display option. To do so, execute the following command: 

export DISPLAY=localhost:1.0 

As you install the PEA, you must supply the username and password of an AACG 
user. You can use the logon credentials of any user configured on the AACG instance 
you upgraded in Chapter 2. It’s recommended, however, that you create a user called 
wsclient, and specify that user during PEA installation. For information on creating 
AACG users, see the Application Access Controls Governor User Guide for version 
8.2.1. 

When you configure an Oracle EBS instance as an AACG data source, AACG gen-
erates a data source ID number. You must supply that number as you install the PEA. 
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Thus sequence matters: Install AACG on its server and configure each EBS instance 
as a data source (see Chapter 2) before you install the PEA on any EBS instance.  

In the Oracle EBS instance on which you are installing the PEA, navigate to the cus-
tom application TOP (conventionally called XXLAAPPS_TOP) created on the Preven-
tive Controls Governor forms server. Execute a directory listing to determine if it 
has a subdirectory named mesg. If not, create the subdirectory: 

mkdir mesg 

Downloading and Preparing Files 
Create a staging directory on the server that supports Oracle E-Business Suite. 
When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Suite Disk in your Oracle 
media pack. On it locate ag-pea-installation-8.2.1-SNAPSHOT-oebs-package.zip. 
Copy it to the staging directory, and extract its contents into that directory.  

The extraction should produce subdirectories of the staging directory called db, 
fndload, Forms, and lib, each of which contains files. Also, files called ag-pea-
installation-8.2.1-SNAPSHOT.jar, install.properties, and pea.properties reside in 
the staging directory. 

2. In the staging directory, use a text editor to open and edit the pea.properties file. 
(This step is required regardless of whether you are performing automated or man-
ual installation.) Provide values for the following properties: 

• pea.datasource.id=<number> 

Supply the data source ID assigned by AACG to the Oracle EBS instance in 
which you are installing the PEA. (This value is available in the AACG Data 
Administration panel; see “Data Sources,” page 2-6).  

• pea.aacg.webservice.server=<servername> 

In place of <servername>, supply the name of the server on which AACG 
is installed (on which Tomcat is installed and the ags.war file is deployed; 
see step 3 et sequens, beginning on page 2-4). 

• pea.aacg.webservice.port=<portNumber> 

In place of <portNumber>, supply  the Tomcat port number — 8080 (if you 
accepted the default value when you installed Tomcat) or your configured value 
(if you changed the default during Tomcat installation). 

• pea.aacg.webservice.url=/<ags>/services/AGService/ 

This property specifies the URL of the webservice where the AACG instance 
is installed. This URL should be /ags/services/AGService/ (remove the angle 
brackets from <ags>  if they appear in the properties file).  

• pea.aacg.webservice.username=wsclient 

If you created a wsclient user on your AACG instance, supply the value 
wsclient here. If not, supply the user name configured for any user of Appli-
cation Access Controls Governor 8.2.1. For example, AACG comes with one 
user, admin, configured by default, so admin would be a legitimate value. 
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• pea.aacg.webservice.password=<password> 

In place of <password>, enter the password for the user identified in the 
previous property. If that’s wsclient, supply the password for that user. If 
you chose admin, the password is also admin. (For security purposes, however, 
you are advised to change this password. If you do, and if you supplied admin 
as the userName in the previous property, supply the updated password here.)  

• pea.aacg.webservice.timeout=<number of seconds> 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 
The default value is 30. 

Other properties are internal to AACG. These include pea.type, pea.userkeys, 
pea.responsibility.accesstype, and pea.test. Do not modify their values. 

3. To perform the automated installation, also use a text editor to open and edit the 
install.properties file in the staging directory. (For a manual installation, this step 
is unnecessary.) Provide values for the following properties: 

• APPS_USER_NAME = APPS 

Supply the username for the database schema that supports your Oracle 
EBS instance. Typically, this value is APPS.  

• APPS_PASSWORD = apps_schema_password 

Supply the password for the Oracle EBS database schema identified in the 
previous property. 

• XXLAAPPS_USER_NAME = XXLAAPPS 

Supply the username for the database schema that supports PCG installed on 
your Oracle EBS instance. Typically, this value is XXLAAPPS.  

• XXLAAPPS_PASSWORD = XXLAAPPS_passsword 

Supply the password for the Preventive Controls Governor database schema 
identified in the previous property. 

• HOST = hostname 

Supply the host name for the Oracle EBS database server. 

• PORT = number 

Supply the port number at which the Oracle EBS database server communi-
cates with other applications. 

• SID = service_identifier 

Supply the service identifier (SID) for the Oracle EBS database server. 

• FREQUENCY = 30 

Supply a number that sets the interval, in minutes, at which two PEA concur-
rent programs are to run. AACG User Provisioning Poll handles the approval 
or rejection of User Provisioning requests in the Oracle EBS instance. AACG 
User Provisioning Request Recovery transmits stored requests to AACG 
when communications with the EBS instance have been interrupted, then 
restored. The recommended value for both programs is 30. 

4. Execute the environment file, if it is not included in the profile. Run this command: 

. $APPL_TOP/$APPLFENV 
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Automated Installation 
Once you have downloaded files and prepared them, execute the following steps to 
complete an automated installation. Remember, you can attempt the automated instal-
lation only if the Oracle EBS concurrent manager server and forms server reside on 
the same instance. 

1. Navigate to your staging directory. 

2. Run the installation file. Execute the following command: 

java -jar ag-pea-installation-8.2.1-SNAPSHOT.jar 

3. When the file finishes running, review its log file: In the staging directory, use a 
text editor to open the file debugInstall.log. It notes status for several installa-
tion stages (Status of Packages, Status of Concurrent Programs, Status of Load 
Java, and Status of Forms), as well as for overall installation.  

• If the status for each is Success, PEA is installed. Ignore the manual instal-
lation procedure. 

• Otherwise, the debugInstall.log file lists errors that have occurred at each 
stage. Either resolve the errors and retry the automated installation process, 
or complete the manual installation process (see the next section).  

Manual Installation  
If your Oracle EBS concurrent manager server and forms server reside on separate 
instances, or if the automated PEA installation has failed, execute a manual installa-
tion instead. Once you have downloaded files and prepared them, complete the fol-
lowing sections. 

Forms Installation 

First, install forms. The PEA uses forms in twelve languages, for which you will 
need to know language codes as you perform the installation. These codes include: 

D German JA Japanese 

DK Danish KO Korean 

E Spanish PTB Brazilian Portuguese 

F French US American English 

FRC French Canadian ZHS Simplified Chinese 

I Italian ZHT Traditional Chinese 

Complete the following steps:  

1. Navigate to your staging directory. 

2. Execute the following command to execute the package (PKS).  

(Here and in subsequent steps, appsSchemaName and appsSchemaPassword are the 
user name and password for the database schema used by Oracle E-Business Suite.) 

sqlplus appsSchemaName/appsSchemaPassword 
@db/aacg_provdb_pkg.pks 
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3. Execute the following command to execute the package body (PKB). 

sqlplus appsSchemaName/appsSchemaPassword 
@db/aacg_provdb_pkg.pkb 

4. To set the environment variable, execute one of the following commands, once 
for each language. As you do, replace the placeholder CODE with the appropriate 
language code (see page 3-4). 

If you use Oracle E-Business Suite Release 12: 

export FORMS_PATH=$FORMS_PATH:$AU_TOP/forms/CODE 

If you use Oracle EBS 11.5.10: 

export FORMS60_PATH=$FORMS60_PATH:$AU_TOP/forms/CODE 

5. Execute one of the following commands to compile the library: 

For Oracle E-Business Suite Release 12: 

frmcmp_batch module=Forms/AACG_PROV.pll module_type=library 
userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/AACG_PROV.pll module_type=library 
userid=appsSchemaName/appsSchemaPassWord 

6. Execute the following command to copy the compiled library.  

cp Forms/AACG_PROV.*  $AU_TOP/resource 

7. To compile the forms, execute one of the following commands, once for each 
language. Again, as you do, replace the placeholder CODE with the appropriate 
language code (see page 3-4). 

If you use Oracle EBS Release 12: 

frmcmp_batch module=Forms/CODE/LAASCAUS.fmb 
userid=appsSchemaName/appsSchemaPassWord 

If you use Oracle EBS 11.5.10: 

f60gen module=Forms/CODE/LAASCAUS.fmb 
userid=appsSchemaName/appsSchemaPassWord 

8. To back up the compiled forms, execute the following command, once for each 
language. Again, as you do, replace the placeholder CODE with the appropriate 
language code (see page 3-4). 

cp $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 
$XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx.orig 

(If you followed recommendations as you installed Preventive Controls Gover-
nor, you selected XXLAAPPS as the application short name, and the environment 
variable shown in this command — $XXLAAPPS_TOP — is correct. If you chose 
another application short name as you installed Preventive Controls Governor, 
make sure the environment variable in this command and the next reflects the 
application short name you created.) 

9. To copy the compiled form, execute the following command once for each 
language. Again, as you do, replace the placeholder CODE with the appropriate 
language code (see page 3-4). 

cp Forms/LAASCAUS.fmx $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 
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Concurrent Programs Installation  

Change to your staging directory and, from it, run the following commands to set up 
concurrent programs that support AACG User Provisioning. In these commands: 

• appsSchemaName and appsSchemaPassword are the user name and password 
for the database schema used by Oracle E-Business Suite. 

• XXLAAPPSUserName is the user name for the database schema that supports Pre-
ventive Controls Governor. This value is case-sensitive.  

• frequency is a number setting the interval, in minutes, between scheduled runs of 
concurrent programs (see the description of the FREQUENCY option on page 3-3).  

Execute the following command to execute the AACG User Provisioning Poll con-
current program: 

sqlplus appsSchemaName/appsSchemaPassword 
@db/aacgexecutable.sql XXLAAPPSUserName frequency 

Execute the following command to execute the AACG User Provisioning Request 
Recovery concurrent program: 

sqlplus appsSchemaName/appsSchemaPassword 
@db/aacgexecrecover.sql XXLAAPPSUserName frequency 

Once this initial setup is complete, execute the following command once for each of 
the twelve supported languages, so that concurrent-program messages, parameter names, 
and descriptions are available in each language. As before: 

• Replace the placehoder CODE with an appropriate language code (see page 3-4). 

• appsSchemaName and appsSchemaPassword are the user name and password 
for the database schema used by Oracle E-Business Suite. 

• stagedir is the path to the staging directory in which you copied and extracted 
PEA files. 

FNDLOAD appsSchemaName/appsSchemaPassword 0 Y UPLOAD 
$FND_TOP/patch/115/import/afcpprog.lct stagedir/fndload/CODE/ 
AACG_CONCURRENT_PROGRAMS.ldt  

Lookup Table Insertions 

From your staging directory, execute the following command to insert records in an 
LAA_lookup table. In this command, xxlaappsSchemaName and 
xxlaappsSchemaPassword are the user name and password for the database schema 
used by Preventive Controls Governor. 

sqlplus xxlaappsSchemaName/xxlaappsSchemaPassword 
@db/addproperties.sql 

Load Java 

Complete the following steps: 

1. Set the DB environment of APPS (the Oracle EBS database). 

2. Execute the following commands. These commands should not error out: 

dropjava 
loadjava 
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3. Execute the following commands. Here (and in steps 4 and 5), appsUserName 
and appsUserPassword are the user name and password for the database used 
by Oracle E-Business Suite. 

dropjava -user appsUserName/appsPassword -verbose  -resolve 
lib/ag-pea-8.1.2-SNAPSHOT.jar 

dropjava -user appsUserName/appsPassword -verbose  -resolve 
pea.properties 

4. Execute the following commands to load the pea jar into the database.  

loadjava -user appsUserName/appsPassword -verbose  
-resolve lib/ag-pea-common-8.2.1-SNAPSHOT.jar 

loadjava -user appsUserName/appsPassword -verbose  
-resolve lib/ag-pea-oebs-8.2.1-SNAPSHOT.jar 

5. Execute the following command to load the modified pea.properties file into the 
database: 

loadjava -user appsUserName/appsPassword -verbose  
-resolve pea.properties 

Postinstallation Steps 

Regardless of whether you used the automated or manual installation process, run 
the Generate Messages concurrent program once for each of the twelve languages 
the PEA supports. To do so, log in to Oracle E-Business Suite as any user with the 
Application Developer responsibility, and select that responsibility. Then, for each 
language: 

1. Select the Requests: Run option in the Application Developer Navigator. 

2. The Submit a New Request window appears. In it, select Single Request and 
click on the OK button. 

3. The Submit Request window appears. In its Name field, query for Generate 
Messages. (Press the F11 key; type the value Generate Messages in the Name 
field; press Ctrl+F11.) 

4. A Parameter window appears. In it, enter the following: 

• Language: The language code (see page 3-4) appropriate for one of the 
twelve languages the PEA supports 

• Application: GRC Controls Custom 

• Mode: DB_TO_RUNTIME 

Click on the OK button. 

5. In the Submit Request window, click on the Submit button. 

6. A pop-up window informs you of an ID number for the concurrent request. 
Make a note of the number, and then click on the OK button to close the 
message. 

7. Optionally, verify that the request has been completed successfully: 

a. Click on View in the menu bar, then on Requests in the View menu. 
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b. A Find Requests form opens. In it, click on the Specific Request radio 
button. Type the ID number of your concurrent request in the Request ID 
field, and click on the Find button. 

c. A Requests form opens. In the row displaying information about your 
request, ensure that the entry in the Phase field is Completed (you may need 
to click on the Refresh Data button), and the entry in the Status field is 
Normal. 

d. Close the Request form: Click on the × symbol in its upper right corner. 
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4 

Installing the PeopleSoft PEA 

In support of the AACG User Provisioning feature, install a Provisioning Embedded 
Agent (PEA) on each instance of PeopleSoft Enterprise that is to be subject to AACG 
analysis. For PeopleSoft, User Provisioning requires PeopleTools 8.49, PeopleSoft 
9.0 FIN or PeopleSoft 9.0 HR, and Java. Even if you have installed the PEA for ver-
sion 8.2.0, you should reinstall it for version 8.2.1. 

You can install AACG 8.2.1 on its server without installing the PEA on PeopleSoft 
instances. If so, however, AACG would not be able to apply User Provisioning to 
PeopleSoft instances. To implement User Provisioning subsequently, install the 
PEA on each PeopleSoft instance for which you want to enable User Provisioning. 
(For PeopleSoft instances, there is no requirement to install an application compar-
able to Preventive Controls Governor, which is necessary in Oracle EBS instances.) 

As you install the PEA, you supply the username and password of an AACG user. 
You can use the logon credentials of any user on the AACG instance you upgraded 
in Chapter 2. It’s recommended, however, that you create a user called wsclient, and 
specify that user during PEA installation. For information on creating AACG users, 
see the Application Access Controls Governor User Guide for version 8.2.1. 

When you configure a PeopleSoft instance as an AACG data source, AACG gener-
ates a data source ID number. You must supply that number as you install the PEA. 
Thus sequence matters: Install AACG on its server and configure each PeopleSoft 
instance as a data source (see Chapter 2) before you install the PEA on any PeopleSoft 
instance.  

Downloading and Preparing Files 

Create a staging directory on the server that supports a PeopleSoft Financials or HR 
instance. When this directory is created, complete the following steps: 

1. Locate the PeopleSoft Enterprise Application Access Controls Governor media 
pack. On it locate ag-pea-installation-8.2.1-SNAPSHOT-ps-package.zip. Copy it to 
the staging directory, and extract its contents into that directory. 

The extraction should produce subdirectories of the staging directory called lib, 
AACG_PS_FIN90_PEA_82, and AACG_PS_HR90_PEA_82, each of which contains 
files. Also, files called ag-pea-ps-8.2.1-SNAPSHOT.jar, pea.properties, and 
log4j.properties reside in the staging directory. 
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2. In the staging directory, use a text editor to open and edit the pea.properties file. 
Provide values for the following properties: 

• pea.datasource.id=<number> 

Supply the data source ID assigned by AACG to the PeopleSoft instance in 
which you are installing the PEA. (This value is available in the AACG Data 
Administration panel; see “Data Sources,” page 2-6).  

• pea.aacg.webservice.server=<servername> 

In place of <servername>, supply the name of the server on which AACG 
is installed (on which Tomcat is installed and the ags.war file is deployed; 
see step 3 et sequens, beginning on page 2-4). 

• pea.aacg.webservice.port=<portNumber> 

In place of <portNumber>, supply  the Tomcat port number — 8080 (if you 
accepted the default value when you installed Tomcat) or your configured value 
(if you changed the default during Tomcat installation). 

• pea.aacg.webservice.url=/<ags>/services/AGService/ 

This property specifies the URL of the webservice where the AACG 
instance is installed. This URL should be /ags/services/AGService/ (remove 
the angle brackets from <ags>  if they appear in the properties file). 

• pea.aacg.webservice.username=wsclient 

If you created a wsclient user on your AACG instance, supply the value 
wsclient here. If not, supply the user name configured for any user of Appli-
cation Access Controls Governor 8.2.1. For example, AACG comes with one 
user, admin, configured by default, so admin would be a legitimate value. 

• pea.aacg.webservice.password=<password> 

In place of <password>, substitute the password configured for the user 
identified in the previous property. If that’s wsclient, you would of course 
supply the password you created for that user. If you chose admin, the pass-
word is also admin. (For security purposes, however, you are advised to 
change this password. If you do, and if you supplied admin as the userName 
in the previous property, supply the updated password here.) 

• pea.aacg.webservice.timeout=<number of seconds> 

Timeout, in seconds, for communication with the PeopleSoft schema. The 
default value is 300. 

• pea.aacg.pea.ds.schema.sid=<service_identifier> 

Supply the service identifier (SID) for the PeopleSoft database server. 

• pea.aacg.pea.ds.schema.port=<number> 

Supply the number for the port at which the PeopleSoft database server 
communicates with other applications. 

• pea.aacg.pea.ds.server=<name> 

Supply the FQDN of the PeopleSoft database server. 
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• pea.aacg.pea.ds.schema.username=<name> 

Supply the user name for the PeopleSoft database schema. 

• pea.aacg.pea.ds.schema.password=<password> 

Supply the password for the username identified in the previous property. 

• pea.aacg.ps.enabled=1|0 

Enter the value 1 to enable the PEA, or the value 0 to disable the PEA. 

• pea.aacg.pea.path.log4j.properties=<path> 

Specify the path to a directory in which the log4j.properties is to reside. An 
initial copy of this file exists in the staging directory. You will edit this file 
(see step 3). Then, later in the installation procedure, you will copy the 
edited version from the staging directory to a directory on the PeopleSoft 
server. This parameter specifies the directory to which you will copy the 
edited file. 

• pea.log.file=<path> 

Set the path and name of a log file that records information about commu-
nications between PeopleSoft and AACG.  

• pea.aacg.pea.ps.frequency=<number of minutes> 

Set a time interval, in minutes, at which an “AACG poller” may be scheduled 
to run. The poller updates role assignments for PeopleSoft users whose User 
Provisioning requests have been resolved in AACG. In the Roles panel of the 
PeopleSoft User Profiles page, a user may select a link labeled “Schedule 
AACG Poller”; if so, the poller runs at intervals defined by this parameter. 

Other properties in the pea.properties file are internal to AACG. These include 
pea.responsibility.accesstype and pea.userkeys. Do not modify their values. 

To modify any of these values — for example, the interval at which the AACG 
poller runs — edit the file and then completely reinstall the PEA. Once the 
poller is scheduled to run, the only way to stop it is to “bounce” the PeopleSoft 
instance. To restart the poller, a user would then need to select the “Schedule 
AACG Poller” link in the Roles panel of the PeopleSoft User Profiles page.  

3. In the staging directory, use a text editor to open and edit the log4j.properties 
file. Set its log4j.appender.file.File property to the path and name of a log file 
that records information about AACG code embedded in PeopleSoft. (Note that 
this log is distinct from the one established by the pea.log.file property of the 
pea.properties file.) Do not modify the values of other properties in the 
log4j.properties file. 

Installing the PEA 

Once you have downloaded files and prepared them, execute the following steps: 

1. To update jar files with properties specified in the edited pea.properties file, run 
the following command from the STAGE directory: 

jar uf ag-pea-ps-8.2.1-SNAPSHOT.jar pea.properties 
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2. Stop the PeopleSoft application server.  

To do so, use the psadmin utility: To start it, execute the command 
PS_HOME\appserv\psadmin (on a Linux server) or PS_HOME\appserv\psadmin.exe 
(on a Windows server). In either case, replace PS_HOME with the full path to the 
highest-level directory in which PeopleSoft components are installed. If neces-
sary, see PeopleSoft documentation for information on using the psadmin utility. 

3. Copy the following files from the lib subdirectory of your staging directory to 
the PS_HOME\appserv\classes directory: 

ag-pea-common-8.2.1-SNAPSHOT.jar 
commons-logging-1.1.jar 
log4j-1.2.14.jar 
ojdbc14-10.2.0.3.jar 

4. Copy the following file from the your staging directory to the PS_HOME\appserv\ 
classes directory: 

ag-pea-ps-8.2.1-SNAPSHOT.jar 

5. Copy the log4j.properties file from your staging directory to the directory you 
specified for it in the pea.aacg.pea.path.log4j.properties parameter of the 
pea.properties file. 

6. Use the psadmin utility to restart the PeopleSoft application server. (See step 2 
for information on running the psadmin utility.) 

Importing a Project 

To complete the PEA installation, import a PeopleTools project: 

1. Open the PeopleTools Application Designer. Log in as a user who has the 
PeopleSoft administrator role.  

2. Navigate to Tools > Copy Project > From File… 

3. A Copy From File: Select Project dialog opens. In a field labeled “Look in:” 
navigate to your staging directory. This causes subdirectories of the staging 
directory to appear in the large, unlabeled field below the “Look in:” field. This 
also causes AACG_PS_FIN90_PEA_82 and AACG_PS_HR90_PEA_82 to appear in 
a field labeled “Select Project from the List Below,” and a Select button to 
become active. 

4. For PeopleSoft 9.0 Financials, select AACG_PS_FIN90_PEA_82 in the “Select 
Project” field, and click on the Select button. For PeopleSoft 9.0 HR, select AACG_ 
PS_HR90_PEA_82 in the “Select Project” field, and click on the Select button. 

5. When a “Copy from File” dialog appears, click on the Copy button. After the 
“Progress” dialog disappears, confirm that application objects appear in the 
Application Designer project window. Then click on the “Save All” icon of 
select Save All from the File menu. 

It’s important to follow instructions in the PeopleSoft Application Import/Update 
Installation Guide when you apply an application import/update project to your data-
base. Failure to do so could corrupt your database and cause you to lose customiza-
tions that you have made to your database.  
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